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Unit: Microsoft PowerPoint  2007

Joshua Riedy

Microsoft PowerPoint 2007

Rationale


The first section of my instruction design is the rationale as to why PowerPoint will be taught and the importance for this content for students at the high school level.
Throughout classes and meetings that I have attended; along with classes that I have had the pleasure to teach in the past 5 years I have seen many issues with PowerPoint that have been created to go along with a presentation. During many of these presentations I have seen the presenter read directly from the PowerPoint slides. PowerPoint should be used to enhance a presentation not hinder it. My instructional design helps to show students the correct way to create presentations using PowerPoint and will allow students opportunities to use hands on interaction with PowerPoint. Included with my design will be projects where students will present their PowerPoint presentation topic to the class. This design helps students not only understand PowerPoint, but helps them to be precise, improve their writing, communication skills, and be more sure of themselves for the future when it comes to presenting material to others.

A large portion of my lessons has the student’s hands on working on the computer rather than listening to me teach. I like to allow students that know what is going on to go above and beyond and get more done. This allows me to help those that are behind or having problems one on one. Chiarelott (2006) mentions that instructional design “reflects a teacher’s personal philosophy, style, and belief system about teaching and learning and how to construct learning environments” (p. 85). This helps to explain why each teacher may be teaching the same material differently and that their is more than one way to teach the same material.

When planning lessons for Office applications such as PowerPoint I find myself taking more of a constructivist approach. Disney Learning Partnership (2002) explains that “learning is based on the individual’s construction of understanding and meaning from experience” (p. 87). I find that many of the computer classes that I teach students are motivated and interested to learn the material because they see the relevance and how this material will be useful for them in the near future. By allowing my lessons to revolve around the students they are more motivated to learn.

Whether you use a behaviorist or constructionist view students will be different from class to class and year to year and from class to class. At times a class may be better off with a behaviorist or constructionist type of teaching atmosphere. A lesson can be strictly behaviorist and sometimes constructionist according to the content that needs to be taught. The decision on whether to use each methods depends largely on what the content is and whether there would be enough time to teach all the concepts that need to be covered.

When deciding what instructional model to use I looked at the basic model as my first choice because I was familiar with it because this is what I was taught to use in my undergraduate studies. However after reading about the other models I now see the importance to changing your instructional design based on the material and students that you are teaching. 

The instructional design model that I will be using for my lesson plans is the basic lesson plan. This is a model that I am comfortable with as I have used this same type of model during my undergraduate classes, student teaching, and during my first couple years of teaching. Chiarelott (2006) explains that a basic lesson plan is good for one day lessons, which many of mine are, but can also be extended over a couple days which my lessons tend to do at times. My instructional design will revolve around the students by allowing them to have input as to what project they choose to create a presentation on student’s will be motivated and see that PowerPoint is a program that they can use in other classes and even after they are finished with school.

The rationale of this instructional design goes right along with my statement of purpose for the curriculum of teaching Microsoft Office 2007 at the high school level. Students are going to present projects throughout high school, college, and more than likely during their careers at some point.  

The Microsoft PowerPoint 2007 unit introduces students to many of the key terms that are used in PowerPoint.  Students should be comfortable using PowerPoint because the layout of the Office ribbon is similar to the ribbons that were used in Word, Excel, and Access which they have already covered this year. Students will be learning some of the new vocabulary that is used in PowerPoint along with hands on practical lessons and activities that will help them with the creation of their own PowerPoint. The activities will be quizzes on our Moodle server, step by step guided practice and end of the chapter activities where students need to use what they have learned within the chapter and apply it to create a PowerPoint. While students will be using PowerPoint they will also continue to work in Excel and Word as these 3 programs are a great way to multitask and share information between the programs.

UNIT OUTCOMES

· Students will be able to define what a presentation is. (Knowledge)

· Students will be able to locate the save, print, and open commands. (Comprehension)

· Students will be able to create presentations by creating numerous slides to form a slideshow. (Application)

· Students will be able to demonstrate how to add animations and transitions to a slideshow. (Application)

· Students will choose appropriate transitions and animations to use on a slideshow. (Application)

· Students will apply transitions and animation to present a topic. (Application)

· Students will question what is most important to include on slides in a presentation. (Analysis)

· Students will be able to design slide layouts that are professional and appropriate. (Synthesis)

PREASSESSMENT

Before beginning the Unit on PowerPoint I will have students complete a couple different preassessment activities. The first activity that I will use to find out what my class knows about PowerPoint is ask each student in the class to explain what they currently know about PowerPoint and if they have ever used the program before. 

The second activity that I will have students complete to assess their current PowerPoint skills is to complete written assignment with questions regarding their use of PowerPoint, which will allow me to see how much they know and don’t on the subject of PowerPoint.

PowerPoint 2007 Pre-Assessment

Name: _____________________________

1. Have you ever used PowerPoint?    Yes     No

2. What do you think a presentation is?

3. If you were in charge of giving a presentation to a class, how would you plan out your presentation?

4. With your knowledge of other Office applications what is a theme and how are how could they be useful for creating a presentation?

5. Why is color important when creating a presentation?

6. When using PowerPoint for a presentation what are 4 key points to you need to keep in mind when creating and delivering the presentation?

1. ________________________________ 

2. ________________________________  

3. ________________________________ 

4. ________________________________ 

7. What are three different ways to insert a picture into PowerPoint?

1. ________________________________ 

2. ________________________________ 

3. ________________________________ 

LESSON PLAN #1

I. Concept - Sub Unit: Introduction to PowerPoint/Creating Presentations: Planning, Slides, Editing, Views, Viewing a Presentation 
II. Lesson Objective(s) 

Upon completion of this lesson students will be able to...

1. explain the purpose of a presentation.

2. identify the different parts of the PowerPoint 2007 window.

3. plan a presentation.

4. add and delete slides, and change the order of slides.

5. display a presentation in different views.

III. Procedures

A. Introductory Activity

· Students will be asked:

· What do you think you will learn about PowerPoint?

· What do you think PowerPoint is used for? 

(5 minutes)

· Students will then complete a written Unit preassessment covering the topic of PowerPoint. (5 minutes)

· As a class we will discuss the questions and answers from the preassessment. (5 minutes)

B. Developmental Activity

After reviewing over the preassessment I will show the students where PowerPoint is on their computers. After showing students where the program is located they will be given time to browse around the program and get used to where things are located and investigate the program on their own. (5 minutes)

After allowing students time to look through the program we will discuss some of the key terms than students need to know and understand about PowerPoint. 

What is a Presentation? 

· “an informative speech that usually includes visuals, such as slides”


I will then go over the PowerPoint screen display explaining the layout of PowerPoint 2007 and where items are located. 


The following will be shown using the projector and PowerPoint 2007 and showing these to the students.

1. Microsoft PowerPoint 2007 Window 
2. Adding and Deleting Slides 
3. Adding Slides 
4. Editing a Slide 
5. Placeholders 
6. Serif and Sans Serif Fonts 
7. PowerPoint Views 
8. Viewing a Presentation 
9. Themes 
10. Printing a Presentation 
11. Handouts 
12. Slide Footers 
Students need to brainstorm with a partner and list uses for PowerPoint - Type these out/print/turn in. (5 minutes) 

*The topics below will be read from the book/discussed as a class

Planning a Presentation

You should emphasize to students that the slides of a presentation should be used to enhance and support the lecture or speech, instead of overshadowing the speaker.

Adding and Deleting Slides

To add a slide that contains the content of an existing slide in a presentation, a slide can be duplicated. In the Slides tab, select the slide to be duplicated and then click Home → New Slide → Duplicate Selected Slides.

Slides may be hidden so that they remain in the PowerPoint file but are not displayed in Slide Show view. Hidden slides may be useful when a presentation is to be given to different audiences. 

ie: A presentation for audiences in three different cities may contain city-specific information on three different slides. Depending on the city in which the presentation is given, the pertinent slide can be included and the others hidden. To hide a slide, right-click the slide in the Slides tab and select Hide Slide. To show a slide that was previously hidden, right-click the slide in the Slides tab and select Hide Slide.

Editing a Slide

Home → Reset This command will reset the formatting of the slide placeholders to their original position. 

Formatting guidelines, such as: 

• Keep the size of text on slides large. If the font size needs to be reduced to fit more text on the slide, then there is too much text on the slide and it should be either edited or divided into two slides. 

• Color schemes with light text on a dark background are easiest to read, but require dim lighting in the room when the presentation is played.

- Dark text on a light (preferably white) background work best when the presentation is played in a well-lit room.

• Yellow and red and any bright or neon colors should be avoided because they cause eye strain. 

PowerPoint Views

When covering the material in this section, you may also want to tell students that they can double-click an individual slide in Slide Sorter view to display that slide in Normal view.

Viewing a Presentation

Students will be shown how to use the Slide Show view to see what their presentation will look like in full screen as it will be during their presentation. This is very important when student begin to add animations and transitions to their slides/presentation.

C. Concluding Activity

· Step by step from book covering concepts in the lesson (pg. 504 - 507) (10 minutes)

IV. Assessment/Evaluation Strategy

· Teacher will review preassessments to see where student’s knowledge of PowerPoint is.

· Teacher will review/grade step by step exercises to see if students are able to begin a new presentation, edit slides, and add slides.

V. Materials/Resources 

· Preassessment worksheet

· Textbook

LESSON PLAN #2

I. Concept - Sub Unit: Introduction to PowerPoint/Creating Presentations: Themes, Printing a Presentation, Slide Footers, Slide Master.
II. Lesson Objective(s) 

Upon completion of this lesson students will be able to...

1. Apply a theme to a presentation.

2. Print a presentation.

3. Add footers to slides.

4. Apply a slide master to keep a consistent look throughout a presentation.

III. Procedures

A. Introductory Activity: (10 minutes)
Class discussion - What did you think about PowerPoint yesterday? 

What would you like to add to your slides?

Today we will be learning how to make your slides more appealing by adding a theme to your slides.

Student’s will open PowerPoint 2007 and will follow directions on how to add/browse themes that are a part of PowerPoint 2007

· Additional themes are available on Microsoft Office Online. Click Design → Themes → More Themes on Microsoft Office Online to access additional themes.

Students will then be shown how to 

· Print a presentation -Default is landscape orientation. To change the slides to portrait orientation, click Design → Slide Orientation → Portrait.

· Add footers to slides.

· Apply a slide master to keep a consistent look throughout a presentation.

B. Developmental Activity - (pg. 509) - Step by Step Practice - Applying themes, previewing presentation, adding footer. (10 minutes)
C. Concluding Activity - Lesson 2 Worksheet Activity (20 minutes)
IV Assessment/Evaluation Strategy

Student’s will be assessed on the completion of their PowerPoint Step by Step Practice and completion of PowerPoint Worksheet Activity.

V. Materials/Resources 

· Lesson 2 Worksheet Activity

· Textbook

Chapter 12

Lesson 2 Worksheet Activity

Use PowerPoint to create an interactive board game by completing the following:

· A blank PowerPoint slide is the best type of slide to begin with when creating a grid, similar to a board or interactive quiz game, such as Jeopardy. For example:

· A grid can be created from a series of text boxes (Insert j Text Box) or a table (Insert → Table.) You may need to refer to PowerPoint Help for more information.

· Formatting options on the Home tab, such as Center and Align Text, can be used to position text within a table or text box.

· Hyperlinks link a text box to a slide presentation. To create a hyperlink from selected text to another slide, click Insert → Hyperlink. The Insert Hyperlink dialog box includes the Place in This Document option for inserting a hyperlink to another slide. Click a slide in the dialog box to select the destination for the hyperlink. For example, the 10 Point text box in category 1 could link to a slide containing a question that is worth 10 points.

a) Start PowerPoint and then brainstorm an original idea for a board or interactive quiz game that could be created in PowerPoint.

b) Use text boxes and hyperlinks to create your board or interactive quiz game.

c) Test your board or interactive quiz game with your peers, making edits as necessary.

LESSON PLAN #3

I. Concept - Sub Unit: Introduction to PowerPoint/Creating Presentations:.
II. Lesson Objective(s) 

Upon completion of this lesson students will be able to...

1. Use the Slide Master.
2. Add a graphic to a slide.

3. Add a chart from an Excel workbook to a slide.

4. Create and print speaker notes.

5. E-mail a presentation from PowerPoint.

6. Collaborate on a presentation.

III. Procedures

A. Introductory Activity: (15 minutes)
Students will read from the text pg. 512-519 as a class covering the following topics:

The Slide Master -Identifies Slide Master elements
Formatting the Background - Displays the command on the Slide
Master tab used to change the slide background color.

Adding Graphics to a Slide - Displays the commands on the Insert
tab used to add pictures and graphics.

Creating and Printing Speaker Notes - Displays an example speaker
note.

Reviewing a Presentation - Displays the commands on the Review tab
used to review a presentation.

As each above topic is covered students will be finding/completing the topic on their own computer in PowerPoint.

The Slide Master-  used to be called title master now called slide master in 2007.
· defines formatting and placeholders
· A theme can be applied to a slide master by clicking Slide Master ( Themes. When a theme is applied to a slide master, the theme is also applied to all layouts associated with the slide master.

B. Developmental Activity/Concluding Activity – Ch. 12 Lesson 3 Worksheet (30 minutes)
IV Assessment/Evaluation Strategy – Students will be assessed on the completion of the Ch. 12 Lesson 3 Activity Worksheet.
V. Materials/Resources 

· Lesson 3 Activity Worksheet

Chapter 12

Lesson 3 Worksheet
 

Experiment with formatting by completing the following:
a) Start PowerPoint. On the title slide, type your first name in the title placeholder. Click Home → Text Direction → Rotate all text 90 degrees. The placeholder could then be sized and moved as appropriate.

b) Click the subtitle placeholder and type your last name. Click Home → Text Direction → More Options. A dialog box is displayed: Experiment with the 3-D Format and 3-D Rotation options.

c) Add a new side to the presentation, click in the title placeholder, and type your first name in all capital letters.

d) Select the first name text and click Home ( Change Case ( Sentence Case. What happens? Experiment with the other Change Case options.

e) Quit PowerPoint without saving the presentation.

Chapter 12

POSTASSESSMENT
For my postassessment students will be assessed by completing two different assessments at the end of the unit. The first assessment will be a True/False, Multiple Choice, and Short Answer textbook test. This will usually be taken via our school’s Moodle server so students get immediate feedback and I will be able to assess how students did instantly. For this project I have attached a copy of the questions that would appear on their Moodle test. 

The second assessment that I will use to test the students knowledge will be application based where I will allow students to choose from one of two topic those being: All About me or All about PowerPoint. Students will have to include/incorporate all content covered in the PowerPoint unit and then present this to the class. 
PowerPoint Unit Test

Name: _________________________
True/False

Indicate whether the statement is true or false.

What is a Presentation?

____
1.
PowerPoint presentations are used to enhance a speech.

____
2.
Miniature versions of slides are called thumbnails.

____
3.
The Slide pane displays thumbnails.

____
4.
The panes in a PowerPoint window can be sized.

Planning a Presentation

____
5.
The layout of the title slide should be exactly the same as the other slides in the presentation.

____
6.
The text on a slide should be typed in all capital letters.

____
7.
Slide content should emphasize the key points of the lecture or speech.

____
8.
The content on a slide should contain everything the speaker is going to say while that slide is displayed.

____
9.
Contrast is the difference between the lightness and darkness of two colors.

Adding and Deleting Slides

____
10.
A new presentation contains ten slides.

____
11.
New slides added to a presentation have the Title and Content layout.

____
12.
The same slide layout has to be applied to all the slides in a presentation.

Editing a Slide

____
13.
The slide layout cannot be changed if text has been added to a slide.

____
14.
A placeholder can be dragged to a new position on the slide.

____
15.
Calibri is a serif font.

____
16.
Sans serif fonts are a good choice for titles and headings.

PowerPoint Views

____
17.
The text in a slide is best edited in Normal view.

____
18.
Slide order can be changed in both Normal and Slide Sorter view.

____
19.
In Slide Sorter view, if slide 20 is dragged between slides 6 and 7, it will become slide 7.

____
20.
The Outline tab can be used to display a specific slide.

Viewing a Presentation

____
21.
The PowerPoint window is displayed in Slide Show view.

____
22.
A presentation has to start with slide 1 in Slide Show view.

____
23.
A previous slide can be displayed in Slide Show view.

____
24.
Speaker notes are displayed when the presentation is displayed in Slide Show view.

____
25.
Themes are used to maintain a consistent look throughout a presentation.

____
26.
Themes are only accessible in PowerPoint.

Design Templates and Color Schemes

____
27.
The color scheme of a theme cannot be changed.

Printing a Presentation

____
28.
The Handouts option always prints 6 slides per page.

____
29.
Only the first slide in a presentation can be viewed when previewing a presentation.

____
30.
Text typed in the Notes pane can be printed with the corresponding slide.

____
31.
Headers and footers can be added to the printout of a presentation.

____
32.
A time stamp displays the current date in a footer.

Slide Footers

____
33.
Information can be added to the footers of the slides.

The Slide Master 

____
34.
The Slide Master is used to maintain a consistent look throughout a presentation.

____
35.
Slide Master view displays one slide with the Title and Content Layout.

____
36.
Formatting applied to the slide master affects all the slides in the presentation.

____
37.
Formatting applied to a slide master layout affects all the slides in the presentation.

Formatting the Background

____
38.
The slide master is used to change the background color on all of the slides.

Adding Graphics to a Slide

____
39.
Drag a corner handle to move a graphic on a slide.

____
40.
Pictures from a digital camera can be used in a PowerPoint presentation.

____
41.
Charts are used to illustrate numerical data.

____
42.
Home [image: image2.png]
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 Paste are used to copy a chart from an Excel workbook to a PowerPoint slide.

Creating and Printing Speaker Notes

____
43.
The Notes pane can be sized by dragging the top boundary of the pane.

____
44.
Slide Sorter view is used to change the layout and look of printed speaker notes.

____
45.
The Notes Master is used to change the layout and look of printed speaker notes on all slides.

E-Mailing a Presentation

____
46.
A presentation can be e-mailed as an attachment from PowerPoint.

Reviewing a Presentation

____
47.
Comments are displayed in Slide Show view.

____
48.
Comments should be deleted before distributing a presentation.

Multiple Choice

Identify the choice that best completes the statement or answers the question.

What is a Presentation?

____
49.
Which part of the PowerPoint window displays the current slide number and the total number of slides?

	a.
	title bar
	c.
	Notes pane

	b.
	Ribbon
	d.
	status bar


____
50.
Which part of the PowerPoint window displays notes that correspond to the current slide?

	a.
	Quick Access Toolbar
	c.
	Notes pane

	b.
	Slide pane
	d.
	status bar


____
51.
Text, images, and other objects that appear on a slide are the

	a.
	content.
	c.
	thumbnails.

	b.
	layout.
	d.
	audience.


____
52.
Fonts, colors, and accent graphics that appear on a slide are the

	a.
	content.
	c.
	thumbnails in the presentation.

	b.
	contrast elements.
	d.
	design of the slides.


____
53.
The arrangement of text and images on a slide is the

	a.
	content.
	c.
	design.

	b.
	layout.
	d.
	thumbnails.


Adding and Deleting Slides

____
54.
New slides are added

	a.
	before the current slide.

	b.
	after the current slide.

	c.
	as the last slide of the presentation.

	d.
	as the first slide of the presentation.


Editing a Slide

____
55.
The AutoFit feature automatically

	a.
	sizes a graphic proportionately.

	b.
	resizes text to fit in a placeholder.

	c.
	resizes a slide to accommodate the text.

	d.
	resizes a slide when it is projected.


____
56.
Text on a slide is edited by

	a.
	adding a slide transition.

	b.
	selecting the Edit button on the toolbar.

	c.
	clicking a placeholder to place the insertion point and then typing.

	d.
	typing in the Notes pane.


____
57.
Which is a good font choice for large amounts of text?

	a.
	sans serif
	c.
	decorative

	b.
	serif
	d.
	italic


PowerPoint Views

____
58.
Which view divides the window into the Slides and Outline tabs, Slide pane, and Notes pane?

	a.
	Normal view
	c.
	Slide Sorter view

	b.
	Outline view
	d.
	Slide Show view


____
59.
Which view displays thumbnails of all the slides in the presentation?

	a.
	Normal view
	c.
	Slide Sorter view

	b.
	Outline view
	d.
	Slide Show view


____
60.
The order of slides in a presentation can be changed in Slide Sorter view by

	a.
	typing the new order in the Print dialog box.

	b.
	dragging a slide to another position.

	c.
	displaying the Slide Master.

	d.
	clicking View [image: image4.png]


 Order.


____
61.
Which view is useful for changing slide order and selecting multiple slides?

	a.
	Normal view
	c.
	Slide Sorter view

	b.
	Outline view
	d.
	Slide Show view


Viewing a Presentation

____
62.
Which key is pressed to start Slide Show view?

	a.
	F1
	c.
	Enter

	b.
	F5
	d.
	spacebar


____
63.
Which view displays the current slide in full-screen size?

	a.
	Normal view
	c.
	Slide Sorter view

	b.
	Outline view
	d.
	Slide Show view


____
64.
During a slide show, pressing the Esc key

	a.
	displays the last slide.
	c.
	ends the slide show.

	b.
	displays slide 1.
	d.
	displays the previous slide.


____
65.
During a slide show, pressing the N key

	a.
	displays the last slide.
	c.
	displays the next slide.

	b.
	displays slide 1.
	d.
	displays the previous slide.


____
66.
During a slide show, pressing the P key or the Backspace key

	a.
	displays the last slide.
	c.
	displays the next slide.

	b.
	displays slide 1.
	d.
	displays the previous slide.


Themes

____
67.
Which theme is applied to a new presentation?

	a.
	Equity
	c.
	Median

	b.
	Flow
	d.
	Office
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____
68.
The images above are examples of

	a.
	slide layouts.
	c.
	slide masters.

	b.
	themes.
	d.
	animations.


Printing a Presentation

____
69.
Which Print Preview [image: image6.png]


 Print What option prints one slide per page?

	a.
	Slides
	c.
	Notes Pages

	b.
	Handouts
	d.
	Outline View


____
70.
Which Print Preview [image: image7.png]


 Print What option prints a specified number of miniature slides?

	a.
	Slides
	c.
	Notes Pages

	b.
	Handouts
	d.
	Outline View


____
71.
Which Print Preview [image: image8.png]


 Print What option prints one slide in the top half of each page and any text typed in the notes pane in the bottom half of the page?

	a.
	Slides
	c.
	Notes Pages

	b.
	Handouts
	d.
	Outline View


The Slide Master

____
72.
Which is not a default footer placeholder on the slide master?

	a.
	date
	c.
	presentation title

	b.
	footer text
	d.
	slide number


Adding Graphics to a Slide

____
73.
Insert [image: image9.png]


 Clip Art is used to add

	a.
	a digital camera picture.

	b.
	a scanned picture.

	c.
	a graphic created by an artist using illustration software.

	d.
	WordArt.


Formatting the Background

____
74.
Which color combination would be the easiest to read?

	a.
	red background, black text

	b.
	light yellow background, light orange text

	c.
	dark blue background, white text

	d.
	dark green background, pink text


Adding a Chart to a Slide

____
75.
Which application would most likely be needed to copy a chart?

	a.
	Word
	c.
	Access

	b.
	Excel
	d.
	Outlook


Creating and Printing Speaker Notes

____
76.
Which is used to change the look of printed speaker notes?

	a.
	Slide Master
	c.
	Notes Master

	b.
	Speaker Master
	d.
	Handouts Master


Completion

Complete each statement.

What is a Presentation 

77.
A smaller version of a slide is called a(n) ____________________.

Planning a Presentation
78.
The difference in lightness and darkness of two colors is called the ____________________.

Editing a Slide

79.
Slides contain ____________________ for holding text and other content.

Themes

80.
Office, Metro, Flow, and Median are examples of ____________________.

Reviewing a Presentation

81.
When collaborating on a presentation, ____________________ can help explain edits.

Short Answer

Planning a Presentation


82.
List the three steps in the presentation planning process.

Planning a Presentation

83.
When creating a presentation, why is it important to define the audience of the presentation?

Planning a Presentation

84.
List one rule to follow when formatting presentation text.

Creating and Printing Speaker Notes

85.
Why is it a good idea to create speaker notes?

PowerPoint Unit Test

Name: _Key_____________________
True/False

Indicate whether the statement is true or false.

What is a Presentation?

_T___
1.
PowerPoint presentations are used to enhance a speech.

_T___
2.
Miniature versions of slides are called thumbnails.

_F___
3.
The Slide pane displays thumbnails.

_T___
4.
The panes in a PowerPoint window can be sized.

Planning a Presentation

_F___
5.
The layout of the title slide should be exactly the same as the other slides in the presentation.

_F___
6.
The text on a slide should be typed in all capital letters.

_T___
7.
Slide content should emphasize the key points of the lecture or speech.

_F___
8.
The content on a slide should contain everything the speaker is going to say while that slide is displayed.

_T___
9.
Contrast is the difference between the lightness and darkness of two colors.

Adding and Deleting Slides

_F___
10.
A new presentation contains ten slides.

_F___
11.
New slides added to a presentation have the Title and Content layout.

_F___
12.
The same slide layout has to be applied to all the slides in a presentation.

Editing a Slide

_F___
13.
The slide layout cannot be changed if text has been added to a slide.

_T___
14.
A placeholder can be dragged to a new position on the slide.

_F___
15.
Calibri is a serif font.

_T___
16.
Sans serif fonts are a good choice for titles and headings.

PowerPoint Views

_T___
17.
The text in a slide is best edited in Normal view.

_T___
18.
Slide order can be changed in both Normal and Slide Sorter view.

_T___
19.
In Slide Sorter view, if slide 20 is dragged between slides 6 and 7, it will become slide 7.

_T___
20.
The Outline tab can be used to display a specific slide.

Viewing a Presentation

_F___
21.
The PowerPoint window is displayed in Slide Show view.

_F___
22.
A presentation has to start with slide 1 in Slide Show view.

_T___
23.
A previous slide can be displayed in Slide Show view.

_F___
24.
Speaker notes are displayed when the presentation is displayed in Slide Show view.

_T___
25.
Themes are used to maintain a consistent look throughout a presentation.

_F___
26.
Themes are only accessible in PowerPoint.

Design Templates and Color Schemes

_F___
27.
The color scheme of a theme cannot be changed.

Printing a Presentation

_F___
28.
The Handouts option always prints 6 slides per page.

_F___
29.
Only the first slide in a presentation can be viewed when previewing a presentation.

_T___
30.
Text typed in the Notes pane can be printed with the corresponding slide.

_T___
31.
Headers and footers can be added to the printout of a presentation.

_T___
32.
A time stamp displays the current date in a footer.

Slide Footers

_T___
33.
Information can be added to the footers of the slides.

The Slide Master 

_T___
34.
The Slide Master is used to maintain a consistent look throughout a presentation.

_F___
35.
Slide Master view displays one slide with the Title and Content Layout.

_T___
36.
Formatting applied to the slide master affects all the slides in the presentation.

_F___
37.
Formatting applied to a slide master layout affects all the slides in the presentation.

Formatting the Background

_F___
38.
The slide master is used to change the background color on all of the slides.

Adding Graphics to a Slide

_F___
39.
Drag a corner handle to move a graphic on a slide.

_T___
40.
Pictures from a digital camera can be used in a PowerPoint presentation.

_T___
41.
Charts are used to illustrate numerical data.

_T___
42.
Home [image: image10.png]


 Copy and Home [image: image11.png]


 Paste are used to copy a chart from an Excel workbook to a PowerPoint slide.

Creating and Printing Speaker Notes

_T___
43.
The Notes pane can be sized by dragging the top boundary of the pane.

_F___
44.
Slide Sorter view is used to change the layout and look of printed speaker notes.

_T___
45.
The Notes Master is used to change the layout and look of printed speaker notes on all slides.

E-Mailing a Presentation

_T___
46.
A presentation can be e-mailed as an attachment from PowerPoint.

Reviewing a Presentation

_F___
47.
Comments are displayed in Slide Show view.

_T___
48.
Comments should be deleted before distributing a presentation.

Multiple Choice

Identify the choice that best completes the statement or answers the question.

What is a Presentation?

_D___
49.
Which part of the PowerPoint window displays the current slide number and the total number of slides?

	a.
	title bar
	c.
	Notes pane

	b.
	Ribbon
	d.
	status bar


_C___
50.
Which part of the PowerPoint window displays notes that correspond to the current slide?

	a.
	Quick Access Toolbar
	c.
	Notes pane

	b.
	Slide pane
	d.
	status bar


_A___
51.
Text, images, and other objects that appear on a slide are the

	a.
	content.
	c.
	thumbnails.

	b.
	layout.
	d.
	audience.


_D___
52.
Fonts, colors, and accent graphics that appear on a slide are the

	a.
	content.
	c.
	thumbnails in the presentation.

	b.
	contrast elements.
	d.
	design of the slides.


_B___
53.
The arrangement of text and images on a slide is the

	a.
	content.
	c.
	design.

	b.
	layout.
	d.
	thumbnails.


Adding and Deleting Slides

_B___
54.
New slides are added

	a.
	before the current slide.

	b.
	after the current slide.

	c.
	as the last slide of the presentation.

	d.
	as the first slide of the presentation.


Editing a Slide

_B___
55.
The AutoFit feature automatically

	a.
	sizes a graphic proportionately.

	b.
	resizes text to fit in a placeholder.

	c.
	resizes a slide to accommodate the text.

	d.
	resizes a slide when it is projected.


_C___
56.
Text on a slide is edited by

	a.
	adding a slide transition.

	b.
	selecting the Edit button on the toolbar.

	c.
	clicking a placeholder to place the insertion point and then typing.

	d.
	typing in the Notes pane.


_B___
57.
Which is a good font choice for large amounts of text?

	a.
	sans serif
	c.
	decorative

	b.
	Serif
	d.
	italic


PowerPoint Views

_A___
58.
Which view divides the window into the Slides and Outline tabs, Slide pane, and Notes pane?

	a.
	Normal view
	c.
	Slide Sorter view

	b.
	Outline view
	d.
	Slide Show view


_C___
59.
Which view displays thumbnails of all the slides in the presentation?

	a.
	Normal view
	c.
	Slide Sorter view

	b.
	Outline view
	d.
	Slide Show view


_B___
60.
The order of slides in a presentation can be changed in Slide Sorter view by

	a.
	typing the new order in the Print dialog box.

	b.
	dragging a slide to another position.

	c.
	displaying the Slide Master.

	d.
	clicking View [image: image12.png]


 Order.


_C___
61.
Which view is useful for changing slide order and selecting multiple slides?

	a.
	Normal view
	c.
	Slide Sorter view

	b.
	Outline view
	d.
	Slide Show view


Viewing a Presentation

_B___
62.
Which key is pressed to start Slide Show view?

	a.
	F1
	c.
	Enter

	b.
	F5
	d.
	spacebar


_D___
63.
Which view displays the current slide in full-screen size?

	a.
	Normal view
	c.
	Slide Sorter view

	b.
	Outline view
	d.
	Slide Show view


_C___
64.
During a slide show, pressing the Esc key

	a.
	displays the last slide.
	c.
	ends the slide show.

	b.
	displays slide 1.
	d.
	displays the previous slide.


_C___
65.
During a slide show, pressing the N key

	a.
	displays the last slide.
	c.
	displays the next slide.

	b.
	displays slide 1.
	d.
	displays the previous slide.


_D___
66.
During a slide show, pressing the P key or the Backspace key

	a.
	displays the last slide.
	c.
	displays the next slide.

	b.
	displays slide 1.
	d.
	displays the previous slide.


Themes

_D___
67.
Which theme is applied to a new presentation?

	a.
	Equity
	c.
	Median

	b.
	Flow
	d.
	Office
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_B___
68.
The images above are examples of

	a.
	slide layouts.
	c.
	slide masters.

	b.
	themes.
	d.
	animations.


Printing a Presentation

_A___
69.
Which Print Preview [image: image14.png]


 Print What option prints one slide per page?

	a.
	Slides
	c.
	Notes Pages

	b.
	Handouts
	d.
	Outline View


_B___
70.
Which Print Preview [image: image15.png]


 Print What option prints a specified number of miniature slides?

	a.
	Slides
	c.
	Notes Pages

	b.
	Handouts
	d.
	Outline View


_C___
71.
Which Print Preview [image: image16.png]


 Print What option prints one slide in the top half of each page and any text typed in the notes pane in the bottom half of the page?

	a.
	Slides
	c.
	Notes Pages

	b.
	Handouts
	d.
	Outline View


The Slide Master

_C___
72.
Which is not a default footer placeholder on the slide master?

	a.
	Date
	c.
	presentation title

	b.
	footer text
	d.
	slide number


Adding Graphics to a Slide

_C___
73.
Insert [image: image17.png]


 Clip Art is used to add

	a.
	a digital camera picture.

	b.
	a scanned picture.

	c.
	a graphic created by an artist using illustration software.

	d.
	WordArt.


Formatting the Background

_C___
74.
Which color combination would be the easiest to read?

	a.
	red background, black text

	b.
	light yellow background, light orange text

	c.
	dark blue background, white text

	d.
	dark green background, pink text


Adding a Chart to a Slide

_B___
75.
Which application would most likely be needed to copy a chart?

	a.
	Word
	c.
	Access

	b.
	Excel
	d.
	Outlook


Creating and Printing Speaker Notes

_C___
76.
Which is used to change the look of printed speaker notes?

	a.
	Slide Master
	c.
	Notes Master

	b.
	Speaker Master
	d.
	Handouts Master


Completion

Complete each statement.

What is a Presentation 

77.
A smaller version of a slide is called a(n) _thumbnail___________________.

Planning a Presentation

78.
The difference in lightness and darkness of two colors is called the _contrast___________________.

Editing a Slide

79.
Slides contain _placeholders___________________ for holding text and other content.

Themes

80.
Office, Metro, Flow, and Median are examples of __themes__________________.

Reviewing a Presentation

81.
When collaborating on a presentation, _comments___________________ can help explain edits.

Short Answer

Planning a Presentation


82.
List the three steps in the presentation planning process.

· Plan lecture or speech
· Determine content/layout of slides

· Determine slide design/sketch slides

Planning a Presentation

83.
When creating a presentation, why is it important to define the audience of the presentation?

· Audience determines speech styles
Planning a Presentation

84.
List one rule to follow when formatting presentation text.

· Limit fonts to 3 or less
· Avoid uppercase letters

· Use a color that contrasts with background

Creating and Printing Speaker Notes

85.
Why is it a good idea to create speaker notes? 
· to help remember information that expands on slide content
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